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Conventions
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The typographic conventions used in this help are described below.

Convention
Bold

Menu...MenuOption

CAPS

ltalics

Contact Us

Description

Used to denote components of the user interface such as
buttons, field names, menus, and menu options.

For example, the New button.

Select the menu from the menu bar then select the menu
option from the menu.

For example, File...Open would mean to select the File menu
and then the Open option.

Used to denote the name of a key on the keyboard.

For example, the ENTER key.

Used to denote emphasis, captions and the result of an action
in a procedure.

General enquiries on the GPA for DigitalMicrograph should be sent to:

HREM Research Inc.
14-48 Matsukazedai
Higashimatsuyama

Saitama 355-0055
Japan

email: support@hremresearch.com
Website: http://www.hremresearch.com /

Enquiries on GPA of a technical nature should be directed to:

Dr. Martin Hytch

CEMES-CNRS, Toulouse, France
email: hytch@cemes.fr
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Introduction to GPA

Welcome to the GPA Phase. DigitalMicrograph plug-in for strain mapping from high-
resolution transmission electron microscope images (HRTEM), high-resolution scanning
transmission electron microscope images (STEM), or indeed any type of lattice image. The
main reference for the theory is:

M. J. Hytch, E. Snoeck and R. Kilaas, Ultramicroscopy 74 (1998) 131-146.
Quantitative measurement of displacement and strain fields from HREM micrographs

and additionally:

F. Hiie, C.L. Johnson, S. Lartigue-Korinek, G. Wang, P.R. Buseck, M.J. Hjtch,
J. Electron Microscopy 54 (2005) 181-190. Calibration of projector lens distortions.
doi:10.1093/imicro/dfi042.

M. J. Hytch and T. Plamann, Ultramicroscopy 87 (2001) 199-212. Imaging conditions
for reliable measurement of displacement and strain from high-resolution electron
microscope images.

Applications of GPA can be found in the following:

[1] F.Hiie, M.J. Hytch, H. Bender, F. Houdellier, and A. Claverie, Phys. Rev. Lett. 100
(2008) 156602. Direct mapping of strain in a strained-silicon transistor by high-
resolution electron microscopy. doi:10.1103/PhysRevLett.100.156602.

[2] C.L. Johnson, E. Snoeck, M. Ezcurdia, B. Rodriguez-Gonzélez, 1. Pastoriza-Santos,
L.M. Liz-Marzan, and M.J. Hytch, Nature Materials 7 (2008) 120-124. Effects of elastic
anisotropy on strain distributions in decahedral gold nanoparticles.
doi:10.1038/nmat2083.

[3] M.J. Hytch, J.-L. Putaux, J. Thibault, Phil. Mag. 86 (2006) 4641-4656. Stress and
strain around grain-boundary dislocations measured by high-resolution electron
microscopy. doi:10.1080/14786430600743876.

[4] J.L. Taraci, M.J. Hytch, T. Clement, P. Peralta, M.R. McCartney, J. Drucker and

S.T. Picraux, Nanotechnology 16 (2005) 2365-2371. Strain mapping in nanowires.
doi:10.1088/0957-44/16/10/062.

[5] M. J. Hjtch, J-L. Putaux, J-M. Pénisson, Nature 423 (2003) 270-273. Measurement of
the displacement field around dislocations to 0.034 by electron microscopy.
doi:10.1038/nature01638.

Software requirements

The following is a list of the software requirements necessary to run the GPA plug-in:

- DigitalMicrograph (GATAN™)

- USB Key Driver

-  HREM Mouse Tool Plug-in (Free-ware downloadable from www.hremresearch.com)
- IPU Plug-in (Free-ware downloadable from www.hremresearch.com)

_4-
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Software Installation

Installing USB Key Driver
The user key driver should be installed by following the instructions given by the key driver installer.
The key driver installer comes with GPA, or you can find it on our web site.

Installing GPA Plug-in
The plug-in can be installed by drag-and-drop copy to the folder “Pluglns” (The Pluglns folder should
exist under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglns folder, GPA menu
commands will appear under “GPA Phase” menu.

Installing Mouse Tools
All the files relating Mouse tool plug-in can be installed by drag-and-drop copy to the folder “Pluglns.’
(The Pluglns folder should exist under a normal installation of the DigitalMicrograph.)

B

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglns folder, the Mouse
tool will appear as an addition to the standard tools.

Installing IPU Plug-in

GPA uses some functions based on the Intel”’ MKL (Math Kernel Library) provided by the IPU plug-in.
All the files relating the IPU plug-in can be installed by drag-and-drop copy. Please consult the
ReadMe file that comes with the IPU plug-in.

In this manual, we will dive straight into the use of the GPA Phase package with some
worked examples. There is also a quick reference guide at the end of this document.

But before starting, there are a few important points to remember:

1. GPA Phase is a plug-in for DigitalMicrograph (Gatan). This means that results are
fully compatible with the other functions present in DM. For example, the phase
images produced, or strain maps, can be analysed or manipulated with functions like
Analysis...Statistics or Process...Simple Math. However, if new images are
produced by these operations, internal GPA variables will not be transferred.
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2. All the commands related to GPA Phase are located in the menu GPA Phase:

GPAPhase HoloLive QPt qDPC
Power Spectrum

Phase calculation...

Define Reference 4

Strain field...

Scan distortion correction... New in v4.5/4.12/4.13
Displacement field... New in v4.7

Fringe displacement New in v4.7

Fringe deformation

Repeat Project >
Phase Maths 4
Phase Tools >

Show Reference Area

Add Color Marker

Image Group >
Project 4
Distortion Info »
Help »
About GPA

3. The only other additional feature to DigitalMicrograph is located in the Standard
Tools Window:

NV £

This mouse tool is a regular feature of other HREM Research plug-ins and is used in GPA
Phase only for the selection of spots in the Power Spectrum, as we will see.

New features in version 4.7

It might seem ironic but we have waited for the version 4.7 to include the direct determination
of displacement fields from phase images. There are two main reasons for this. The first is
that most people are interested in strain measurements, and these are most accurately
determined directly from the phase images. The second, more technical reason is that phase
unwrapping is necessary to determine the displacement field and there is no unique solution to
phase unwrapping in two dimensions. We have had to make a compromise.

Here are the two new functions:
¢ Fringe displacement. Displacements perpendicular to a single set of lattice fringes
are determined, either in pixels if the image is not calibrated or in nm for calibrated
images.
¢ Displacement field. The full 2D vector displacements in the plane of the image are
determined from 2 phase images.
These commands are the natural partners to Fringe deformation and Strain field
respectively.
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New features of version 4.5

We have included in GPA 4.5 a new feature:

e Scan distortion correction. STEM images are plagued by distortions due to the scan.
These distortions are random and therefore cannot be corrected from a reference
image, unlike CCD distortions or projector lens distortions for HRTEM images.
Several ways have been proposed to correct them. In GPA 4.5, we have implemented
a simple routine to correct “fly-back” distortions: the rigid displacements of a whole
scan lines.

New features of version 4.0

GPA Phase 4.0 has the possibility of calculating strain maps from multiple, i.e. more than two,
phase images:

e Multi-phase strain maps. In principle, strain maps can be calculated from just two
phase images. For previous versions of GPA, we typically chose the phase images
from the two strongest spots in the Power Spectrum. But if many viable spots are
available (notably for aberration-corrected HRTEM images) it is a pity to miss the
extra information. A routine has therefore been implemented in v4, which allows you
to calculate the strain maps from as many phase images as you like. The strain maps
are a result of a least-squares fitting procedure and aims to improve the signal-to-noise
ratio of the measured strain. See the Additional Functions section for details.

This is the first time we have updated the basic Strain field... routine since the original
version of GPA, so we thought it worth a version change!

To know more about the idea behind using multiple phase images see:
A. K. Gutakovskii, A. L. Chuvilin, and S. A. Song, Bulletin of the Russian Academy of
Sciences: Physics 71 (2007) 1426—1432. Application of high-resolution electron
microscopy for visualization and quantitative analysis of strain fields in heterostructures.

New features of version 3

GPA Phase 3.0 can handle the complex image, which will be obtained by using electron
hologram or an exit wave reconstruction procedure.
Additional features include:

e Polynomial fit to Lens distortion correction. Lens distortion is normally changes
slowly, and can be expressed by polynomial function. Thus, a polynomial fitting will
reduce random noise in the lens distortion pattern.

¢ Rotatable ROI. In some case you may want to use the reference rectangle area that is
not parallel to horizontal or vertical direction. Now, after placing a regular rectangle
ROI to show the size you want, you can rotate the rectangle ROI as well as change the
size.

e Color marker. The intensity scale can be added to images (for example, deformation
maps) in the form of a color bar, including minimum and maximum values.

New features of version 2

GPA Phase 2.0 is faster and more user friendly than GPA Phase 1.0. In addition, there are a
number of new features, such as:
e Calibrated images. If the analysed image has a calibrated scale (in nm, for example),
all phase results will be calibrated accordingly (even when binned, see below). More
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importantly, the spatial resolution of the results will be indicated when defining the
mask size in GPA Phase...Calculate Phase.

Image binning. The resulting phase image can be chosen to have a reduced size (in
pixels) with respect to the original image, using the binning option in GPA
Phase...Calculate Phase. Analysing a 2048 by 2048 pixel image at binning 4 will
produce results 512 square. This speeds calculations and liberates space. No
information is lost, as the mask used in Fourier space is always much smaller than the
original picture size.

Automatic distortion correction. Previously, a reference image had to be analysed
manually each time the phase images were to be corrected. Now, this is done
automatically. The reference image (distortion information) just needs to be analysed
once and saved using the menu GPA Phase...Distortion Info. All subsequent phase
analyses can then call up and automatic correction using the Distortion tab in GPA
Phase...Calculate Phase.

Repeat phase project. All the operations carried out during a phase project can be
repeated on a new image with just one click using GPA Phase...Repeat phase
project, including strain fields. This means of course that the reciprocal lattice vectors
need to be roughly the same as before. This command is ideal for analysing a series of
images of a specimen.
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GPA Phase Tutorial

Getting Started

Open the image “GPA Test 0” using the DM command File...Open from the GPA Phase
Manual folder:

= Technical note: you can find out how this
image was created by looking at the script “GPA
Test image 0.s” in the Phase Manual folder.
Indeed, you can play with the image by
changing the script, in particular the variable
dPhase which determines the displacement.

e e N o A i NS A M R

e o 0 A 18 A 4 STV e

Hint: to run a script in DM,
press CTRL-ENTER.

Power Spectrum

Phase calculation...
Technical note: in GPA, the image does not

have to be a power of two in size (e.g. 512 by
512). However, streaks may appear in the power
spectrum if greatly different in size from a
power of two.

Define Reference »
Scan distortion correction...
Displacement field...

Strain field...

Fringe displacement

Fringe deformation

Repeat Project 4
Phase Maths »
Phase Tools 4

Show Reference Area

Add Color Marker

Image Group >
Project 4
Reference Image 4
Help >
About GPA

You will see an image similar to this:
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Technical note: the power spectrum is the modulus squared
of the Fourier transform of the image. People are often
surprised by the lack of a central spot in the power spectrum
but this is normal for images where the mean intensity is
zero, an important difference with diffraction patterns. The
horizontal streaking of the spots is due to the interfaces in the
image and is not, in this case, an artefact.

Now choose the mouse tool: > R & @and click on one of the spots.

Why not zoom in using the DM magnifying glass tool: h @ 77

Technical note: do not worry about “hitting” the
spot exactly. GPA will automatically hunt locally
for the maximum intensity in the spot, even though
the red square marks the actual pixel you hit.

Hint: if you wish to delete your mark,
click on the mouse mark again with
the SHIFT key down, or use the DM
arrow tool to select and delete.

For the moment we want only one spot marked, but GPA can deal with multiple selections, as
we will see later. The chosen reciprocal lattice vector will be referred to as g.

We are now ready to calculate our first Phase Image:

c Phase calculation... >
>

Scan distortion correction...
Displacement field...

Strain field...

Fringe displacement

Fringe deformation

Repeat Project >
Phase Maths »
Phase Tools »
Show Reference Area

Add Color Marker

Image Group >
Project 4
Reference Image >
Help >

About GPA

-10 -
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The following dialogue box will appear:

i Create Phase Images @
Project Name: |Project1

Mask I Display I Distortion ]

Technical note: the choice of the mask type
(shape) is not that critical though the hard circular
mask is to be avoided (only included for

" Hard Circular Mask

Size completeness). Hard masks in Fourier space
lage x| [00331  1/pixel Apply introduce rippling effects in real-space, which is
Spatial resolution: [302  pixels why smooth masks are preferred. Mask size is the
most important parameter.
binning: |1~ P P
ok | cance |

The first choice “Project Name” gives the title prefix for all subsequent results e.g. phase
images, strain maps etc. Choose a short name preferably. For the mask type, use the default
value of “Cosine Mask” for the moment. The most important parameter is the mask size
(radius) and can be modified using the menu “Size” from small (radius = g/4), medium (g/3)
to large (g/2). As you do this, the result of your choice will be seen on the Power Spectrum:

Technical note: the radius of the mask shows the
area selected in Fourier space around the spot of
interest. Decreasing the mask radius will produce
smoother results but with less spatial resolution.
The maximum recommended size is g/2
corresponding to the large mask size.

Now say OK and the phase image will appear:

Technical note: GPA uses the temperature colour
scale for displaying image values. If you prefer
grey scales use the DM menu Object...Image
Display...Color. Similarly, if you wish to change
the maximum and minimum display values use
DM menu Object...Image Display...Contrast or
select an area on the histogram. In any case, the
actual values in the image will not be changed,
only its appearance.

-11 -
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This phase image has values in radians from —r to +n. The next step is to define area which
will correspond to the reference lattice. Use the DM ROI tool (region of interest tool) to
t and area:

Technical note: choose an area of
undistorted lattice as your reference
area, recognised in the phase image as
an area of uniform contrast or uniform
gradient. For example, do not choose an
area which straddles the interfaces.
Having said that, please experiment.

and choose the next GPA phase command Define Reference.

GPA Phase
Hint: if you do not like the reference area,

el > just grab and slide the ROI across the

Scan distortion correction.. image. GPA will automatically update the
Displacement ield.. ]‘ reference area. This function can be

Strain fied.. deactivated in Define Reference...Setup.

Power Spectrum

Phase calculation...

The result will be the following:

Technical note: if you want to know the actual
values of the reference lattice g=(gx,gy) then look in
the DM Results Window, and if necessary apply
Define Reference...Setup...Show gx, gy. Values
are in pixels’!

The phase image now has a well-defined reference lattice and can be interpreted. The uniform
area of phase shows that the lattice is identical to the reference (here in brown). The change in
the relative phase shows that the central band (here in yellow) is displaced with respect to the
reference. You can see this on the original image. This is the basis of the geometric phase
technique: the measurement of displacement of lattice fringes.

By choosing the DM profiling tool, the phase shift can be visualised:

-12 -
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@oen

0 100 200 300 400

In the reference area the phase is zero and in the central band takes a value of 2.2 radians.
This value can be verified in the original script used to create the image “GPA Test image 0.
Now choose the reference area in the central band, and you will see that the displacement is
reversed. This illustrates the overall principle:

Only relative phase shifts are important and all measurements refer to the
particular reference lattice used.

Fringe displacements

From theory, geometric phase is related to displacement by the following equation:

P,(r) =-2mg.u(r)
where Py(r) is the geometric phase of a set of lattice fringes with reciprocal lattice vector g,
u(r) is the displacement and r the position coordinate in the image. This can be further
simplified if we consider only displacements perpendicular to the fringes, ug, and that the
fringe spacing, d, is equal to 1/ g:

P, =-2mu,/d
In terms of displacement this means that:
P
ug = - % d

i.e. the phase in units of 27 gives the displacement as a fraction of the lattice spacing. A phase
shift of 2.2 radians represents a displacement of -2.2/21t = -0.3501 of a lattice spacing. As a
new feature of version 4.7, these relations have been programmed for you.

Select the phase image as the upper-most image and choose Fringe displacement... from the
main menu:

GPA Phase | Help

Power Spectrum Note: the command Displacement
Phase calculation... field... for the measurement of 2D
Define Reference ’ displacement fields will be detailed at
the end of the manual.

Scan distortion correction...

Displacement field...

Strain field...

c Fringe displacement ,
Fringe detormation

- 13-
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You should see the following result:

E& H: Fringe displacement (pixel... ‘E

£k D: Project1 P1 [(a@] =]

Note: the colour change between the
phase and the displacement image is
due to the negative sign in the phase-
displacement equation.

Look back to the original fringe image
and you will see that the fringes are
displaced in the negative g-direction
(here, the g-direction is upward).

Phase Fringe displacement

You might like to take a profile across Fringe displacement image to look at the actual values:

Since the original image is not calibrated (in nm/pixel) the displacement is given in pixels.
Given the fringe spacing was 15 pixels, the exact displacement should be -5.252 pixels.

As you can see from the profile, the result is not exactly this value: there are fluctuations.
These come from the fact that noise was added to the original simulated image to make it look
more realistic. Delineate a rectangular ROI and use the DM function Analysis...Statistics...
Mean and Std. Dev. You will obtain the result in the Output window, something like

Mean = -5.278 pixels, Standard Deviation = 0.0522 pixels.

In the presence of noise exact values are never obtained: there will always be
an uncertainty, quantified by the standard deviation. One hopes that the true
value is within the range of uncertainty...

Fringe deformation mapping

Most people are interested in measuring deformation and strain, so let us move quickly on
from the phase images and displacement. Open the image “GPA Test 1”:

- 14 -
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Hint: to see the lattice rotation,
view the image at a glancing
angle to the page. And if you like,
try and measure the rotation with
standard tools.

A cunning distortion of the fringes is hidden in this image. To measure this distortion the
routine as ever is to produce a phase image with a well-defined reference. Here is a typical
result:

Technical note: do not worry about the “phase
jumps” i.e. where the phase suddenly goes from
black to white. This is quite normal and results from
the normalisation of the phase between —r and 7.
Imagine the phase going round a circle moving
seamlessly from 0 to 7 to —t and back again. No
discontinuity is present in the underlying lattice

The abrupt change in gradient of the phase from one side to the other is witness to the
deformation. Let GPA calculate this deformation from the phase image using Fringe

Deformation:

+# P: Fringe de M[=[E3|l + Q: Fringe rotat... [M[=]E3

The first image shows the change in lattice spacing relative to the reference lattice in
fractional units (i.e. 0.02 means 2% expansion). The paired image shows the rotation of the
lattice fringes with respect to the reference in degrees (in-plane rotation of course) and
positive anticlockwise. By default the minimum and maximum values are (+5% deformation
and +5° rotation). Now the deformation and rotation can be visualised by taking profiles or
measured in ROI boxes using DM Analysis...Statistics...Mean and Std. Dev.
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Precision and Spatial Resolution

GPA allows the visualisation of lattice deformation. In the previous example, we can clearly
see that the image is divided neatly into two regions. On the left, lattice fringes with a
particular lattice spacing and orientation and on the right, lattice fringes expanded and rotated
with respect to this lattice (or vice-versa, if the reference lattice was chosen on the right).

GPA is much more than this, however, it is a tool for measuring deformation. Deformation
can be measured using the profile tools and statistical tools in specified areas, as has been
seen. Each pixel in the image is also a measure of the local deformation and lattice orientation.
The question is how local and how precise?

It is not possible to give a general theoretical answer to this question. An experimental way of
estimating will be given here: the standard deviation of the fluctuations in a uniform part of
the lattice gives the precision, and the length scale of these fluctuations gives the spatial
resolution. The fluctuations are assumed to be due to noise, of course. The standard deviation
is easily measured using the DM command Analysis...Statistics...Mean and Std. Dev.

The spatial resolution depends on the mask size used in the analysis. Did you spot the new
feature of GPA 2.0 when creating the phase image for GPA test 1?

i Create Phase Images

Technical note: If the original image was

Project Name: [GPAtest 1 not calibrated, the spatial resolution is
Mask | Display | Distortin | displayed in pixels. If you recalibrate the

original image, you need to recalculate the
Power Spectrum.

Type
(¢ Cosine Mask

" Hard Circular Mask

Hint: To calibrate an image using

DM draw a line, of which you know
the length in nm, using the DM ROI
tools. Then use Analysis/Calibrate...
To show the scale bar use Edit/Data

0K | Cancel l Bar...

In this case, the spatial resolution of the results will be 0.2 nm. We also provide the radius of
the FFT mask, x in pixels!, which gives a spatial resolution of 1/x in pixels. Changing the
mask size will change the spatial resolution (updated automatically).

The precision is a direct function of the noise in the image. Double the amount of noise by
modifying the original script “GPA Test image 1” and see the results. Similarly, the spatial
resolution is a direct function of the Mask size used in the GPA analysis. Repeat the
experiment with a smaller mask. Notice that the precision has increased but the spatial
resolution has decreased. This is an essential feature of local measurements: precision is
inversely related to spatial resolution.

When quoting results from GPA, always quote the precision at a certain
spatial resolution.

- 16 -
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Determining strain tensors

In order to measure 2-D strain tensors, two sets of lattice fringes are necessary in the image,
as in the image “GPA Test 2”:

Technical note: a deformation is
indeed present here, see the script
“GPA Test image 2”.

Two phase images are needed to calculate strain, and to do this two spots in the Power
Spectrum can be selected at once.

Technical note: in principle, it does not matter
which two spots you choose, so long as their g-
vectors are not parallel. In practice, the highest
precision is obtained with low order spots and
ones nearest to right-angles with respect to each
other. Spots absent in the crystal structure are to
be avoided (e.g. present due to double diffraction,
misalignment etc.).

Carry out Phase Calculation and notice that a mask is placed around both spots in the Power
Spectrum. Choose a project name of “Test 2" and the results will look like the following:

= F: Test 2 P1

-17 -
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As previously, a reference lattice needs to be defined. This is done by defining an area with
the DM ROI tool on one of the phase images exactly like the previous examples:

#F: Test 2 P1 CIEIX) [:H: Test 2 P2 - [B[x

Hint: it is not always easy to recognise
a good reference region. Just go ahead
and try, and if necessary change the
selection. Usually the situation becomes
clearer after calculating the strain field.

When the Define Reference command is used, GPA will automatically redefine the reference
area on all of the phase images in the group (here, two phase images):

= F: Test 2 P1 EOX :i
_. |

Technical note: it is important for
consistency to have the same area of
crystal acting as a reference. This
feature can be deactivated in Define
Reference...setup.

The strain tensor can now be determined with the command Strain field.... When asked,
select the above two images “Test 2 P1” and “Test 2 P2” for the calculation (default values
are the two most recent images). In the next dialogue, the angle requested corresponds to the
direction of the x-axis with respect to the horizontal (angles anticlockwise positive):

Calculate Strain @
Strain WODUOHI
Angle of x-axis to horizontal: |0.0 Hint: if a ROI line tool is

marked on the original
image, the default value will
be parallel to this line.

Show the following images
[V Symmetric Strain Matrix

[V Mean Dilatation
[¥ Rotation Angle

Phase to be used

v Pl P2 Green areas: new features in

GPA 4.0. See later for details.

Un-check All Phases ‘

Choosing the x-axis parallel to the picture horizontal axis (i.e. angle zero) and selecting
symmetric strain matrix, dilatation and rotation, the following image group will be obtained:

- 18 -
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Hint: for definition of
strain tensor, see the
Appendix.

Technical note: strains as fractions (e.g. 0.02 equivalent to 2% strain) and angles in degrees
(anticlockwise positive). Default colour range is +5% strain and £5° rotation.

This is the final results of GPA strain analysis: the complete 2-D strain tensor.
Now it is your job to enjoy and interpret the results!

-19 -
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Additional functions

Strain field calculation with multiple phase images (v 4.0)

In principle, only two phase images are necessary to calculate the 2D strain tensor, and in
previous versions of GPA (up to v3), strain measurements were performed by selecting the
two phase images with the highest signal-to-noise ratio. However, experimental phase images
are noisy, so it is maybe interesting to be able to combine the information from more than 2
phase images. Indeed, now that aberration-corrected HRTEM is more widely available, the
number of useful reflections in the power spectrum has increased significantly. Take a look at
the following example from an image called GPA SiGe SACTEM:

T

5:";: ,"..:"‘
i
1

.
2

i, f{l
i
=

This image was taken on the aberration-corrected SACTEM microscope in Toulouse of SiGe
grown epitaxially on a Si substrate [F. Houdellier & M.J. Hytch, Microelectronic Engineering
84 (2007) 460—463]. Select the 7 spots circled in the power spectrum with the mouse tool and
calculate the amplitude and phase images. Use the large mask size and try and use the spots
in the order indicated above. You should find the following images displayed after defining a
reference area:

-20 -
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Now calculate the strain map:

e Calculate Strain 5
Strain I Option I
[ 1
Angle of x-axis to horizontal: Im

 Show the following images
[V Symmetric Strain Matrix

Hint: You can define the direction of x-
axis by a Line ROI on the original image.
Then, the angle of x-axis to horizontal is
[ Mean Dilatation automatically read from the line ROI.
[~ Rotation Angle

Hint: the default phase images are the two
topmost phase images in DM. Check and
Check All Phases I uncheck the boxes as you like.

OK | Cancel |

By default, strain will be calculated from two phase images, as shown. The default phase
images will be the topmost two phase images in DM, so tick and untick boxes if necessary to
choose P1 and P2 as shown. Verify that the x-axis is parallel to the interface and calculate the
symmetric strain matrix by clicking on OK:

r

ssicebn o | B8] | BETSGely [oeEma

The exx component is on average zero, indicating that the interface is coherent between the
SiGe and the Si. The &yy component shows that the lattice parameter in the SiGe is larger than
in the Si substrate. However, the image is rather noisy. Rather than reducing the mask size,
let us see what using multiple phase images can do.

221 -
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Recalculate the strain but this time, check all phase images as shown:

E& Calculate Strain [ﬂ_h]

Strain I Option I

|
‘ Angle of x-axis to horizontal: |23.6

 Show the following images
[V Symmetric Strain Matrix

[~ Mean Dilatation
[ Rotation Angle

r Phase to be used
v P1[vP2[vP3
[v P4|v P5[v P6
v P

iUn-check All Phases

Hint: use the Check/Un-check All
Phases button to select/deselect all
the phase images.

OK I Cancel I

All the boxes should now be ticked. You can use “Check All Phases” button at the bottom of
the Phase List. Click on OK to calculate the strain map:

E{lgv:SiGe_Boc o | @ | 3] W:SiGeEyy o @ =]

The improvement to the &yy component is impressive. What has been done? The information
from all the phase images has been combined in a least-squares fitting routine to obtain the
strain maps. In the default version, defined in the option menu, all the phase images are
treated equally.

As always, care should be taken when interpreting the results and phase images should not be
used blindly. Have a look at an alternative selection of spots:
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shown.

Hint: remember to unselect spots with
the mouse tool, just hold down SHIFT
and click on the spot to delete.
In this case, unselect the old spots 5, 6

and 7, and select new 5, 6 and 7 spots as

The spots 5,6 and 7 have been changed to produce the following amplitude and phase images:
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If we unthinkingly choose all the 7 phase images, the following strain maps would be

obtained:

%}3 AH: Project6 Exx

[=[E=]

AL Project6 Eyy

o] O
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It can be seen that the strain maps are worse than with just 2 phase images! The reason can be
found in the fifth phase image. The amplitude is almost zero in the SiGe layer for this set of
fringes. Uncheck this phase image from the list and you will find a much better result.

As a general recommendation, look at the amplitude images and choose only phase images
which you would be happy to choose when using only two phase images. Experiment, and try
different spots and numbers of spots for the calculation.

Options

Not all phase images have equal significance. We have therefore included a possibility to
weight the phase images in the fitting procedure, the default being no weighting (none). Here
is the list of those options:

% Calculate Strain @

Strain Option !

[V Normalize by g

WeightMode |None = Hint: choose none if you can
Spot Amplitude gfter screening the amplitude
Image Amplitude images to check that all the phase
Sprtlotensiy images are viable.
Image Intensity

OK | Cancel [

There are different choices which you can play with: spot amplitude meaning the amplitude
of the spot used in Fourier space (with the same weight to all the pixels), image amplitude
meaning the corresponding amplitude image (with the weight therefore varying pixel to pixel),
spot intensity meaning the intensity of the spot in Fourier space, and image intensity
meaning the square of the amplitude image.

When the “Normalize by g” is checked, the weight of 1/g will be applied. This will sometimes
give better result, because the phase value is proportional to g (spatial frequency), but the
significances (the intensity) of the spot with high spatial frequency is normally becomes low.

Try using one of these options on the last example. You should find that the problematic fifth
phase image (P5) will no longer affect the results. The resulting strain map will however have
a lower signal-to-noise than the none option of the first set of phase images (or by deselecting
PS5 manually). The reason is that the spot intensities decrease rapidly and the fitting is
dominated by the first 3 spots, say. As mentioned in the hint, it is always best to screen the
phase images yourself before calculating the strain and use the none option if possible.
Anyway, have fun and see what you find.
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Geometric distortion correction

All optical systems distort the images they form. CCD cameras and scanners (for digitising
negatives for example) introduce additional distortions. Fortunately, these geometric
distortions are usually fixed for a given system. It is therefore possible to eliminate these
distortions by measuring them (usually only once) and then correcting subsequent images.
The procedure is described in Hiie et al. J. Electron Microscopy 54 (2005) 181. The paper
concerns projector lens distortions but is general for all geometrical distortions. All that is
necessary is an image of a perfect crystal (or any other perfectly regular lattice).

Open the image “GPA Test distortion” which is a simulation of a translation boundary:

Calculate the two phase images as usual after selecting the spots in the power spectrum:

r N

~ —

The information contained in the image is dominated by the geometrical distortions.
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Distortion correction

In order to correct for distortions, you need to set up a reference image. Open the reference
image “GPA Test reference” image and calculate the Power Spectrum.

Select two spots and calculate two phase images. In principle, any two non-colinear spots
suffice.

LA

With a phase image selected, use the menu Distortion Info and Save As... A standard
Window's dialog will appear to save a file. By default, a folder is created in My Images folder
but you can place your reference images anywhere. A good place, if you have administrator
rights, is in the DigitalMicrograph folder in a folder called GPA reference images. Give the
file a name, say “GPA Test reference”, and click OK. The program will save the GPA Test
reference image with the necessary information for later use.

Technical note: it is
not absolutely
necessary to define a
reference area but it is
good practise.
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Redo a Phase Calculation... for the GPA Test distortion image. At the menu stage, click on
the Distortion tab. It should look something like this:

is/Create Phase Images @

Project Name:

Mask] Display Distortionl

Camera: I Ronchi camera USC.dm3 Ll

™ Apply Correction

Lens: IGPA Test reference image noisy.dm3 LI
vV Apply Correction
™ Polynomial fit Order: ,G
™ Exclude border pisels |32 v
I Show fitings

0K Cancel

Now you can choose the reference image (Distortion Info) you want using the scroll down
menu Camera or Lens depending on the type of distortion. For example, you could have a list
reference images for different cameras on different microscopes. The GPA Test reference
corresponds to projector lens distortions so after selecting the reference in the Lens menu, tick
Apply Correction and click OK.

The phase images will automatically be corrected and, after using Define Reference, will
have a nicely uniform appearance. Only the phase variation due to the crystal structure will
be present:

You only need to define the reference image (Distortion Info) once. From now on, it will be
available in the Phase Calculation...Distortion tab. If you wish to delete it, just use
Distortion Info...Delete.
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Polynomial fitting

You will not always be so lucky with the reference image. Open the more realistic image GPA
Test reference noisy:

Technical note: this
was created simply by
adding noise to the
previous GPA Test
reference image.

Repeat the procedure for defining a reference image for the distortions, and recalculate the
phase image of GPA Test distortion using the new noisy reference. You will find the
following results for P1 and P2:

The results are much noisier than the previous example, because the noise in the reference
image is effectively added to the image. To alleviate this problem, we have included in GPA
Phase 3.0 the possibility of applying a polynomial fit to the reference image phases before
subtracting them from the experimental phase. Recalculate the GPA Test distortion phases by
ticking the Polynomial fit option:
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i Create Phase Images @

Project Name: [Projectd Technical note: projector lens

: e distortions are theoretically a
Mask | Display ~Distortion I

polynomial of order 3. It is therefore
Camera: | Ronchi camera USC.dm3 =l logical to use the same order for the
I~ Apply Correction fitting. However, higher orders can
Lens: IGPA Test reference image noisy.dm3 L, be used if necessary.

vV &pply Correction
' Polynomialfit Order: [3 | Hint: it is always worth

) excluding some pixels at

the borders of images to
M B avoid edge effects.

oK | Cancel |

You should find the following result:

The resulting phase images are much smoother, as no additional noise has been added to the
experimental phases. Indeed it would be a pity to add noise to experiments, which are already
difficult to perform!
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Scan distortion correction (v4.13 aka Scan-line correction)

High-angle annular dark-field scanning transmission electron microscopy (HAADF-STEM)
can produce remarkable images of the atomic crystalline lattice. Here is an example from the
TEAM 0.5 microscope at the NCEM Berkeley (courtesy of Marta D. Rossell). Even at
relatively low magnification, the atomic columns are clearly visible and the image looks
highly suitable for Geometric Phase Analysis. However, if we squash the image vertically, we
can see that the atomic lattice is no longer appears straight!
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This is a well-known manifestation of the scan distortion. As the beam is scanned across the
specimen from left to right it can jitter, due to interference from the electronics. At the end of
a line it is swept back to start a new line. However, it does not arrive in exactly the correct
place. The whole line can therefore have an additional displacement with respect to the
previous line of scan: the so-called “fly-back” distortion. The result is highly visible in a
phase image as shown below.

Open the image “GPA scan distortion test image” which shows the full HAADF-STEM
image from Marta. Calculate the phase image for the two (110) spots with a medium-sized
mask.

Be ArSe. (o Bkl
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The phase images are not exactly what one would hope from a (almost) perfect crystal. The
effect on the strain field is even more pronounced:

e

e AL Scan Bxx o[-l

E&N:ScanEyy [ = |

~ ——

%AH:Scan ny‘ (=] ” =] ”ﬁJ

Notice that the horizontal strain component, &xy, is almost distortion free, whereas the vertical
strain component, &yy, the rotation wxy and shear &y are all contaminated by horizontal streaks.
The reason is that distortions come predominantly from the gradient of the phase images in
the y-direction only. Contrary, the gradient of the phase images in the x-direction only
randomly fluctuate over zero. This is because the scan step over horizontal (fast) scan of this
image is almost constant, albeit the atomic lattice is wavy along the vertical direction as
shown before.

Now let us see how the Scan distortion correction... routines work. Here, we assume that
the start point of each scan-line moves not only horizontally but also vertically due to
interference from the environment.

GPA Phase | HoloLive QPt qDPC

Scan distortion correction
Power Spectrum

Phase calculation... Comection direction

Define Reference » The ROl area(s) will be used forthe Scan distortion comection.

Strain field... v Extend ROI

v Show =ran dictartion phase (_SD)
Scan distortion correction...

- v Keep original phase
Displacement field...

Fringe displacement

The original STEM image can be comected for scandine distortion.
v Show corrected STEM image (_SC)

Fringe deformation

Repeat Project » Choose two phase maps

v P1 v P2
Technical note: you need to
have a phase image selected.
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Tick the Show scan distortion and Keep original phase options so that we can follow what
is happening, and you should see the following:

-

= D: Scan P1_SC o |[® ][ =]

= E: Scan P2_SC [ @] =]

L
iz H: Scan P1_SD o |[®][=]

v It Scan P2_SD [o[®@] =]

t‘#: N: Scan P1

Warning: the scan correction works
particularly well on this example, where the
scan system is stable and the scan speed along
the fast (horizontal) scan is almost constant.

Note: It will certainly not work, when there is
a random scan distortion within each scan-line!

Note: If there is a systematic scan distortion
within each line, see Vertical Scan Distortion
Correction later in this section.

The phase images are now almost free of distortions. So how is it done? The routine averages
the phase horizontally (along the x-direction) within a ROI for the scan distortion correction.
If you want, you can use the ROI for the Define Reference for the scan distortion correction.
The Extend ROI option ensures that this is carried out by extending the ROI vertically or
horizontally over the whole image depending on the correction direction. The resulting profile
is then extended over the whole image (see the phase images with _SD) and subtracted from
the original phase image producing a scan-corrected phase image (denoted SC).

These phase images give the resulting strain fields:

Eﬂ: AL Scan Exx \EHEHE’

e ALScanty [ o | @ | 2]

-32-



B AH: Scan Riy|-co- - B[Sl

Bk AM:ScanE. [ o [ @ | & ]

GPA Phase Manual

We can know see that the HAADF-STEM image was in fact taken of a twin boundary. There
is neither expansion nor contraction in x and y, just a rigid-body rotation (Rxy) and shear of
the crystalline lattice (Exy). Experiment yourself with the options to understand their effect.

The scan distortion correction has a capability to merge multiple reference areas in the image.
Here, we consider the case where there is an inclined interface across the image. If we define
the reference area from top to bottom, the scan distortion correction does not work where the
reference area intersects the interface as shown below left. In this case, we can use two
reference areas at the top left and the bottom right as shown in below right. Then, the scan-
line correction works better by combining scan distortion information from these two

reference areas.

i |

1n

S ——

periact

i

!

Xﬂte‘f{ace

B |
I ——

If at least two phases have been calculated without binning, the original STEM image can be
corrected for the scan distortion. When you check “Show corrected STEM image”, the STEM
image corrected for the scan distortion will be displayed (denoted DC).

The original STEM image can be corrected for scan-ine distortion.
Show corrected STEM image (_SC)

Choose two phase maps

[¥]P1 [¥]P2

Technical note: When you calculate more
than two phases, please select two of
them for this command.

[

OK ] [ Cancel
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Scan distortion corrected Power Spectrum of the corrected image

Difference from the original

Scan distortion along the horizontal direction can be easily detected by eye, since the atomic
lattice along the vertical direction looks wavy as shown before. Although it is difficult to
detect the vertical distortion (namely, the variation of spacing between the scan-lines), there
should be a similar amount of distortion. The difference map above demonstrates that similar
amounts of scan jitter appear along both directions.

The power spectrum of the image after scan distortion correction becomes sharp, which
demonstrates the effectiveness of the correction.

Vertical Scan Distortion Correction (v4.13)

When vertical stripes appear in the horizontal strain component, exx, it demonstrates there is a
systematic scan distortion, not a random scan jitter, within the fast (horizontal) scan. This
systematic scan distortion can be corrected in the same way as for the horizontal stripes in the
vertical strain component, gyy, when Vertical is selected from the Correction Direction.
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2D vector displacements (v4.7)

We have already seen in the tutorial the command Fringe displacements to determine
displacements in just one direction (perpendicular to a set of lattice fringes). Here, we will
look at the command Displacement field for the determination of the 2D in-plane vector
displacement field from two phase images. Open and run the script GPA4 test image — 2D
displacement to create the following image and determine the Power Spectrum:

It does not look as if much is going on but calculate the phase images corresponding to the
spots shown above. Define a reference region to the left and you should see the following
results:

B E: Projectl P2 o3| =]

==

& D: Projectl P1

The phase images show that the central region is shifted with respect to the rest of the image.
In this case, both phase image show a shift and therefore we need to combine the two phase
images to determine the displacement vector (see Appendices for the equations). We can do
this with the Displacement field command:
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Power Spectrum

Phase calculation...

Define Reference 4

Displacement field...

Strain field...

Fringe displacement

Fringe deformation

Repeat Project >
Phase Maths 4
Phase Tools 4
Add Color Marker

Image Group >
Project >
Reference Image >
Help >

About GPA

2D Displacement u
Angle of x-axis to horizontal: | [ ‘

[~ Phase to be used
¥lpP1 [¥] P2

[ ok ][ cancel }

GPA Phase Manual

By choosing, for simplicity, the x-axis to be same as that of the image (Angle 0), the

following result is obtained:

Eﬂf G: Displacement ux (nm)

-3 [i_&] £ J: Displacement uy (nm)

Slel=]

These two images represent the x and y-components of the 2D vector displacement, u,
respectively ux and uy. Since the original image was calibrated in nm/pixels, the displacements
are automatically given in nm.

By looking into the original script for creating the image, you can see that the central region is
displaced by exactly (-0.02 nm, 0.04 nm) from the rest. Since noise has been added, the
measured values will not be exactly these. Experiment with the noise level and you will see
how the uncertainty is modified.
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Appendixes
A: Important phase relations

Phase and displacement:
P, (r) = -2mg.u(r)
2D displacement and phase:
1
u(r)= —E[Pgl(r)a1 + sz(r)a2] where g.a, =9,

Phase gradient and reciprocal lattice deviation :
VP, (r) = 2mAg(r)

Strain tensor for small deformations:

€. _1 %+ o, ie e oMo, 0w o _1fou Ou,
2| ax ox = ] 0
j i yoo

€ €.
ox T ey Y2
Mean dilatation :

oodu ) .
Ay =%(%+_j] LA, =%(£ﬂ +€,vy)

dx;  ox,

Rotation (in radians and anti-clockwise positive):
a)“=l %—% ie. o, -1 u, _du,
Y Xy
2| ox; oOx ; Y20 ax oy

Note: these relations are only valid for small deformations. However, GPA
uses the full relations suitable for large deformations (see Appendix in Hytch,
Snoeck, Kilaas.)
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B: Useful DigitalMicrograph commands
DM ROI tool:

Y _:_ = ‘ Hint: to select a square area, hold down SHIFT.
— : To select powers of two, hold down SHIFT-ALT.
DM magnifying glass:

| ¢ H]
] k ’ 7 Hint: to demagnify, press ALT.

C: Rotatable ROl

The edge length will be adjusted by one of the
yellow edges, and the rotation angle will be adjusted
by the yellow cross (+). (You can change the both
edge lengths by dragging the yellow cross when
pushing the SHIFT key.)
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Quick Reference Guide

The GPA Main Menu

The commands in the GPA menu are described below.

GPA Phase | HoloLive QPt qDPC

Power Spectrum
Phase calculation...
Define Reference

Strain field...

Scan distortion correction...

Displacement field...
Fringe displacement

Fringe deformation

Repeat Project
Phase Maths

Phase Tools

Show Reference Area
Add Color Marker
Image Group

Project

Distortion Info

Help
About GPA

Command Description

Power Spectrum First step in the GPA procedure. Calculates and

displays the Fourier transform of the frontmost image.
Spots are then selected in the image of the Fourier
transform (called Power Spectrum) using the mouse
tool.

Phase calculation... Second step in the GPA procedure. Calculates phase

images for the spots selected in the Power Spectrum.
Results for each spot are displayed and managed as
part of a project (see options).

Define Reference Menu concerning the reference lattice and third step
(see sub menus) in the GPA procedure.
Strain field... Calculates the two dimensional deformation tensor.

Asks for two phase images and options (see below).
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Scan distortion
correction...

Corrects scan distortion in STEM using an average
value measured within the user specified ROI.

Displacement field...

Calculates the full 2D vector displacements in the
plane of the image from two phase images.

Fringe displacement

Calculates the displacements perpendicular to a
single set of lattice fringes.

Fringe deformation

Calculates the deformation of lattice fringes from the
frontmost phase image. Displays variation in fringe
spacing (with respect to reference) and orientation (in
degrees, anticlockwise positive).

Repeat Project
(see sub menus)

Allows phase images and other output(s) to be
generated from the frontmost image exactly in the
same way as the selected project. Also allows
details of the current project to be saved for later use
(even in other sessions of DM).

Phase Maths
(see sub menus)

Menu of different mathematical operations which can
be performed on phase images.

Phase Tools
(see sub menus)

Menu of useful operations, not necessarily restricted
to phase images.

Show Reference Area

Show the latest reference area that was used Define
Reference command. You can use this command
even when the reference ROI has been deleted.

Add Color Marker

Adds a color bar and the low and high display ranges.
You can move the whole color marker or change its
size. Since the display ranges are text annotations,
you can move and edit them as you like. The color
marker can be placed outside of the image display.
You can rotate and flip using Edit commands. (The
ratio of the color bar is fixed.)

Image Group Menu to close or save groups of images within a
(see sub menus) particular project.
Project Menu to manage all the images in a particular project.

(see sub menus)

Distortion Info
(see sub menus)

Menu to define Distortion Info obtained from the
reference images for distortion correction due to CCD
cameras or projector lenses.
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Phase Calculation Menu

Create Phase Image Dialog

The components of the dialog are described below.

Component Description

Project Name Name given to the group of images and results

Mask Tab For information about the components of the Mask
tab, see Mask Tab below.

Display Tab For information about the components of the Display
tab, see Display Tab below.

Distortion Tab For information about the components of the
Distortion tab, see Distortion Tab below.

OK Closes the dialog and starts the image calculation
according to the specified parameters.

Cancel Closes the dialog without executing the command.

Mask Tab 5 Create Phase Images @

Size

Project Name: |GPA test1

Mask. | Display | Distortion |

-| [posz t/pbel Appy |
Spatial resolution: 0615 nm

Type
(¢ Cosine Mask

(" Hard Circular Mask

binning: |1 v
oK | Cancel |
Component Description
Type Defines the shape of mask used to isolate the
selected spots in the Fourier transform.
Cosine Mask Half-cosine-shaped mask. Size corresponds to radius

of hard cut-off and cosine quarter period (i.e. first
zero).

Hard Circular Mask

Top-hat function. Size corresponds to radius of hard
cut-off.

Size Defines mask radius of hard cut-off (beyond which
values are set to zero).
Selection Default values of large (g/2), medium (g/3) and small

(g/4). Custom allows any value.
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Text Field

In units of pixels in the FFT.

Apply Button

Displays mask size as circles on Power Spectrum
around selected spots (this is just for display
purposes and is not necessary for the calculation).

Spatial Resolution

Displays the equivalent averaging in real space (but
will appear only if the original image is calibrated).

Binning

Defines if the resulting phase images are to be binned
with respect to the original image thus reducing their
size and speeding the calculation.

Display Tab 5 Create Phase Images @

Mask Display | Distortion |

Project Name: |SZECEE

Show the following images
v Geometric Phase Image

[T Amplitude Image

[ Bragg Filtered Image

oK | Cancel I

Component

Description

Show the following images | Choice of images to be calculated and displayed.

Geometric Phase Image

Geometric phase image.

Amplitude Image

Amplitude of lattice fringes.

Bragg Filtered Image

Bragg filtered image i.e. image of selected lattice
fringes.

42-




GPA Phase Manual

Distortion Tab 5 Create Phase Imaees @

Mask] Display Distortion I

Camera: IGF’A Test reference image.dm3 ;I

Project Name: |GPA test1

[ Apply Correction

Lens: IGF’A Test reference image.dm3 ;I

........................................

|7 Polynomial it Order: |3 -
|7 Exclude border pixels |64 v

[7 Show fittings

oK | Cancel |

Option Description

Camera Selection of the distortion info obtained from
reference images used for correcting camera
distortions (they need to be prepared with the
Distortion Info menu).

Lens Selection of the distortion info obtained from

reference images used for correcting lens distortions
(They need to be prepared with the Distortion Info
menu).

Apply Correction

Activates the use of the camera and/or lens distortion
info to correct distortions. If both are activated, the
corrections will be applied in succession.

Polynomial fit

Activates the use of polynomial fit to the lens
distortion (not for camera distortion).

Order

Specifies the order of polynomial fit.

Exclude border pixels

Specifies the width of border pixels to be excluded
when estimating polynomial fit parameters. (Most of
the cases the border pixels are affected by
discontinuity at the borders. Thus, it is a good idea to
exclude some border pixels.)

Show fittings

Tick to display the polynomial fit in a new window.
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Define Reference Menu Refine

Setup...

Option

Description

Refine

Third step in the GPA procedure. Before running the
command, an area needs to be selected by the DM
rectangular ROl tool. The command defines this
region as the reference lattice and adjusts phase
images accordingly (see options).

Setup...

Opens Setup dialog.

Setup Tab

Setup

v Use Same Area
v Automatic Update

[v Showex By
v Rotatable

]ﬁ Define Referen... @

oK

| Cancel |

Option

Description

Use Same Area

Reference area is automatically applied to all phase
images in the project when using the Refine
command or Automatic Update option.

Automatic Update

Moving the reference area automatically updates the
phase images and reference values.

Show gx,gy Displays the values of the reference lattice gx and gy
in the DM Results window each time the reference
area is updated.

Rotatable Tick to make the rectangular ROI rotatable. The edge

length will be adjusted by one of the yellow edges,
and the rotation angle will be adjusted by the yellow
cross (+). (You can change the both edge lengths by
dragging the yellow cross when pushing the SHIFT
key.)
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Calculate Strain Dialog
(Strain Tab)

GPA Phase Manual

=

% Calculate Strain

Strain | Option [

Angle of x-axis to horizontal: |21

Show the following images
[v Symmetric Strain Matrix

[~ Mean Dilatation
[ Rotation Angle
Phase to be used
v P1[vP2[ P3
[ P4 P5] P6
[~ P7
Check All Phases |

OK | Cancel ]

Component

Description

Angle of x-axis to horizontal

Defines the orientation of the x-axis used for the
strain calculation. Angle defined in degrees from
the horizontal plane of the image to the x-axis
(anticlockwise positive). The values used for the
previous calculation will be shown.

Note: You can specify the orientation of the x-axis
by placing a Line ROI on the original image. In this
case, the angle of the Line ROl appears here
automatically.

Show the following Images

Choice of results to be displayed.

Symmetric Strain Matrix

Images of exx, gyy and gy, to be displayed.

Mean Dilatation

Image of 6xy to be displayed (average of exx and
Eyy).

Rotation Angle

Image of wxy to be displayed. Values in degrees
and anticlockwise positive.

Phase to be used

Select the phases to be used from the phase list.

P1to Pn Phase list with a check box.
Check/Un-Check All Toggle button to check/un-check all phases.
Phases
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Calculate Strain Dialog (% calculate Strain ==
(Option Tab) Strain Option |
[v Normalize by g

Weight Mode |None v

Spot Amplitude
Image Amplitude
Spot Intensity
Image Intensity

ok | cancel |
Component Description
Normalize by g Applies the weight proportional to 1/g.
Weight Mode Selection from a weight list: None/Spot Amplitude/
Image Amplitude/Spot Intensity/Image Intensity.

Scan Distortion Correction menu

Scan Distortion Correction Dialog

Scan distortion correction X

Comection direction

The ROl area(s) will be used for the Scan distortion comection.
v Extend ROI
v Show scan distortion phase (_SD)

v Keep original phase

The original STEM image can be comected for scandine distortion.
v Show corrected STEM image { SC)

Choose two phase maps
v P1 v P2

Component Description

Correction Direction Select a direction of scan distortion correction
from Horizontal and Vertical. The former correct
horizontal fringes, while the latter vertical fringes
caused by scan distortion.
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Extend ROI

Scan distortion will be measured within the ROI
and applied across the whole image according to
the selected correction direction. If checked, the
ROI is extended vertically or horizontally over
the whole image depending on the correction
direction.

Show scan distortion

If checked, the phase maps (denoted “_SD”) used
for the scan distortion correction will be displayed.
in addition to the scan-corrected phase images
(denoted “_SC”).

Keep original phase

If checked, the original phase images will be kept
displayed.

Show corrected STEM
image

If checked, the scan-corrected STEM image will
be displayed (denoted “_SC”).

Here, two phase images should be selected from
the phase list: P1, P2...

Displacement field menu

Displacement field Dialoq

ru_
=~ 2D Displacement I&I

Angle of x-axis to horizontal: |0.0|

Phase to be used
(VIP1 VP2

[ OK ][ Cancel }

Component

Description

Angle of x-axis to horizontal

Defines the orientation of the x-axis used for the
displacement field calculation. Angle defined in
degrees between the x-axis and the horizontal
plane of the image (anticlockwise positive). The
values used for the previous calculation will be
shown.

Note: You can specify the orientation of the x-axis
by placing a Line ROI on the original image. In this
case, the angle of the Line ROl appears here
automatically.

Phase to be used

Select two phases to be used from the phase list.

P1, P2...

Phase list with a check box.
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Repeat...

Save Current Project As...

Clean up Project List...

Option

Description

Repeat

Repeats the same operations to the frontmost image
according to the selected project.

Save Current Project As

Saves the Info of the current project for later use.

Clean up Project List

Removes project Info.

Repeat Project dialoq | Repeat Project <
New Project:
st Pt

Output Options

v Power Spectrum B Define reference

v Phase calculation o

v Fringe deformation

B Strain field

| ok

Option Description

New Project

Defines the name of the new project.

Repeat Project

Defines the repeating project. You can select the
project to be repeated from the current project or the
saved project(s) that will appear in the list.

Output

Power Spectrum

Tick for the power spectrum to be displayed.

Phase calculation

Tick for the phase image to be displayed (including
amplitude and Bragg filtered images if calculated in
the repeating project).

Fringe deformation

Tick for the fringe deformation to be displayed (if
calculated in the repeating project).

Strain field

Tick for the strain field to be displayed (if calculated in
the repeating project).

Options

Define reference

Tick to perform Define reference for the front image
on the same area used in the repeating project.

Note: If not ticked, the same g-vector of the repeating
project will be applied to the front image. This is a
handy way to specify the Reference Area on another
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image taken at the same condition. To do so, at first
process another image to define g-vector, and then
use Repeat Project with Current Project.

Distortion correction

Tick to apply the distortion correction in the same way
of the repeating project.

Phase Maths menu | Add constant phase

Benormalise phase
Add phase images
Subtract phase images
Ihvert phase

Option

Description

Add constant phase

Adds a uniform phase value to the frontmost image
and renormalizes the phase.

Renormalize phase

Renormalizes the phase between —r and +x.

Add phase images

Adds two phase images together (requested in a
dialog box) and displays result in a third window (after
phase renormalization). If the phases images are in
the same project, the new phase image will have a
reference equal to the sum of the references of the
two phase images. Otherwise, the new phase image
will have a reference equal to the first phase image
selected.

Subtract phase images

Subtracts two phase images (requested in a dialog
box) and displays result in a third window (after phase
renormalization). If the phases images are in the
same project, the new phase image will have a
reference equal to the difference of the references of
the two phase images. Otherwise, the new phase
image will have a reference equal to the first phase
image selected.

Invert phase Calculates the negative of the phase (and inverts the
g-vector).
Phase Tools menu Show gx, gy
Sample by 2
Contours...
Create moires
Import phase images
Option Description
Show gx, gy Displays in the DM Results window the values of the
reference lattice gx and gy in 1/pixels.
Sample by 2 Rebins the frontmost phase image by two and
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multiplies the reference by two (thus preserving the
reference values gx and gy in pixels™ of the newly
sampled image).

Contours

Superimposes contours on the frontmost image (see
options).

Create moirés

Creates a moiré image from the frontmost phase
image. Asks for the magnification factor n equivalent
to moiré fringes every n lattice fringes.

Import phase images

Imports images into GPA, so that they are recognized
as phase images. Dialog boxes will appear asking for
the values gx and gy in pixels™. If the image has tags
called Phase:gx and Phase:gy, these will be proposed
as default. Images that are imported together will be
placed in a project.

Contours dialog

(Option Tab)

5 Contours

Option

Contour spacing:
Number of contours: |00
Mid contour: |00

Contour width:

194"

oK | Cancel |

Component

Description

Contour spacing

Step in image values between each contour.

Number of contours

Total number of contours displayed.

Mid contour Image value corresponding to mid contour.

Contour width Contour line width in pixels.

Image Group menu Save

Close

Component Description

Save Saves (with dialog) all images in a project of the
same type as the frontmost image (e.g.
deformation images).

Close Closes (without saving) all images of the same
type as the frontmost image.
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Project menu Hide
Show
Save
Close
Component Description
Hide Hides all the images in a project.
Show Shows all the images in a hidden project.
Save Saves all the images in a project (with save dialog
window).
Close Closes all the images in a project without saving.

Distortion Info menu Save As...
Delete...

Component Description

Save As Saves the current project image as a reference
image for image distortions. Two phase images
need to have been calculated. The distortion info
(reference image) will then appear in the
Distortion tab described in Phase Calculation.

Delete Deletes a selected distortion info (reference

image).
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